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Preface

This guide describes how to use the Oracle ERP Cloud adapter in your SOA composite
applications and Oracle Service Bus business services.

Audience

This guide is intended for users who want to create, deploy, test, and monitor applications
that use the Oracle ERP Cloud adapter.

Related Resources

Refer to the Oracle Fusion Middleware library on the Oracle Help Center for additional
information.

e For Oracle SOA Suite information, see Oracle SOA Suite.
*  For Oracle Service Bus information, see Oracle Service Bus.
e For adapters information, see On-Premises and Cloud SOA Adapters.

e For versions of platforms and related software for which Oracle products are certified and
supported, review the Certification Matrix.

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.
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Introduction to Oracle ERP Cloud Adapter

This section introduces Oracle ERP Cloud adapter.

Topics

* Oracle ERP Cloud

* Installing the Cloud Adapters

*  Performing Postinstallation Configuration Tasks

»  Specifying the Oracle ERP Cloud Service Catalog Service WSDL or Event Catalog URL
»  Obtaining the Authentication Credentials

* Unsupported Features

» Restrictions

Oracle ERP Cloud

The Oracle ERP Cloud adapter enables you to create an integration with Oracle Enterprise
Resource Planning (ERP) applications.

Oracle ERP Cloud enables you to streamline your enterprise business processes. Oracle
ERP Cloud combines the power of a global business software suite with transactional and
reporting capabilities that address financial, procurement, and project requirements across a
range of business flows and countries. The complete and integrated suite transforms your
organization through the latest social, mobile, and analytic technologies to optimize
collaboration, process efficiency, and compliance while increasing insight into the business.

The Oracle ERP Cloud adapter enables you to easily integrate on-premises or SaaS
applications with Oracle ERP Cloud without having to know about the specific details involved
in the integration. The Oracle ERP Cloud adapter provides the following benefits:

* Integrates easily with the Oracle ERP Cloud application’s WSDL file to produce a
simplified, integration-centric WSDL.

* Generates automatic mapping to the exposed business object or event subscription that
you select during adapter configuration:

— Business object: Represents a self-contained business document that can be acted
upon by the integration. An integration can send requests to create a new record for
that business object. They can send a request either to update or delete an existing
record for a business object. Integrations can also send requests to retrieve
information about one or more records representing that business object.

— Event subscription: Represents an event document to which you subscribe. The
event subscription is raised by the Oracle ERP Cloud application.
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Chapter 1
Installing the Cloud Adapters

< Note:

Oracle ERP Cloud can send events to on-premise systems. To do
S0, you must open the on-premises firewall to enable access from
the outside.

* Automatically handles security policy details required to connect to the Oracle
ERP Cloud application.

* Provides standard error handling capabilities.

» Enables you to map business objects that have polymorphic data structures.

For more information, see Configuring Oracle ERP Cloud Properties.

Installing the Cloud Adapters

This section describes cloud adapter installation details.

See the README. txt file available with the patch for instructions on installing the cloud
adapters.

After you complete adapter installation, perform the tasks described in Performing
Postinstallation Configuration Tasks.

" Note:

For information about supported versions and platforms, see the release
certification matrix at Supported System Configurations.

Performing Postinstallation Configuration Tasks

You must perform postinstallation configuration tasks after installing the cloud
adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud
Adapters Postinstallation Configuration Guide.

Specifying the Oracle ERP Cloud Service Catalog Service
WSDL or Event Catalog URL

You specify a mandatory Oracle ERP Cloud service catalog service WSDL (for
accessing business objects) and optionally an event catalog URL (for accessing event
subscriptions). The service catalog service WSDL is required to configure the adapter
for both inbound and outbound endpoints using either business objects or business
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Chapter 1
Specifying the Oracle ERP Cloud Service Catalog Service WSDL or Event Catalog URL

services. The event catalog URL is required for configuring the inbound adapter for event
subscriptions.

Obtaining the Service Cloud Service WSDL

WSDL Requirements Where Do You Get the WSDL

The URL must be that of a service catalog service The developer creating an Oracle ERP Cloud
WSDL. The service catalog service is a Fusion connection must work with the Oracle ERP Cloud
Application service that returns a list of external service administrator to get the concrete WSDL
services available for integration. It allows clients ~ URL for the service catalog service provisioned for
to retrieve information about all public Fusion the specific SaaS application.

Application service endpoints available for that

instance.

The service catalog service enables clients to
retrieve information about all public Oracle Fusion
Application service endpoints available for that
instance. The information it returns is specific to
the particular cloud instance and also reflects the
new services that may have been introduced in
patches applied to the instance. This service is
used to programmatically discover the SOAP
services available on the cloud instance and
retrieve the necessary metadata to invoke the
SOAP services to manage business objects.

This section describes how to derive the external virtual host and port for a tokenized service
WSDL. The topology information in the Topology Registration setup task contains the
external virtual host and port for the domains and applications. The following instructions
describe the steps for deriving the values using the service catalog service WSDL URL as an
example: https://atf server:port/fndAppCoreServices/ServiceCatalogService.

To access the Review Topology page, the ASM_REVIEW_TOPOLOGY_HIERARCHY_PRIV
entitlement must be granted to the user's job role. The entitlement is granted to the
ASM_APPLICATION_DEPLOYER_DUTY duty role, which is inherited by the duty roles
ASM_APPLICATION_DEVELOPER_DUTY and ASM_APPLICATION_ADMIN_DUTY.

If the menu items and tasks described in the following procedure are not available in your
cloud instance, your user account is missing the required role. Contact your cloud instance
security administrator for assistance.

1. Log in to the cloud instance.

2. Click the Navigator icon in the global area in the top part of the window, then chose
Setup and Maintenance under the Tools heading.

3. Select Review Topology under the Topology Registration section in the Tasks regional
area on the left side of the window.

4. Click the Detailed tab in the middle of the window.

The tab shows the list of domains configured in the cloud instance.
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Specifying the Oracle ERP Cloud Service Catalog Service WSDL or Event Catalog URL
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Setup and Maintenance
| Tasks
Implementations

« Getting Started
+ Configure Offerings
» Manage Implementation Projects
Setup Data Export and Import
* Manage Configuration Packages
» Manage Export and Impart Processes
Implementation Objects
s Manage Offerings and Functional Areas
« Manage Features
+ Manage Business Processes
« Manage Task Lists and Tasks
» Manage Business Objects
Topology Objects
« Manage Domains
+ Manage Enterprise Applications
= Manage Third Party Applications
» Manage Madules
+ Manage Composites
Topology Registration
« Review Topology

| Search: Tasks

Search

Advanced

& G) * | L] 9 0 | APPLICATION IMPLEMENTATION CONSULTANT~ (O

Review Topology Dane

Summary Detailed = Diagnostic Tests

View w Format » Freeze i Detach &l wrap Download Domain Connections »

Name External Server Host External Server Port SMHEPrs Context Root
Environment

&> OSNDomain

i» SCMDomain

 ProjectsDomain

& ProcurementDomain
&> MigrationDomain

&» IDMDomain

&» ICDomain

i» HCMDomain

& FinandialDomain

% CommanCiomain

> CRMDomain

& BIDomain

5. Map the token name for the service path value to the domain name in the

Topology Manager:

Token Name in Service Path

Domain Name

atf_server
crm_server
fin_server
hcm_server
ic_server
prc_server
prj_server
scm_server

CommonDomain
CRMDomain
FinancialDomain
HCMDomain
ICDomain
ProcurementDomain
ProjectsDomain
SCMDomain

6. Expand the domain name and select any external virtual host and port for the
J2EE applications that are deployed on the domain. In the sample window, the
values for this particular instance are fs-your-cloud-hostname and 443,

respectively.

ORACLE"
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Obtaining the Authentication Credentials

ORACLE & @ d | ¥ € @ | APPLICATION_IMPLEMENTATION_CONSULTANT~ (O
Setup and Maintenance
AT Review Topology Dane
Implementations
« Getting Started Summary Detailed Diagnostic Tests
» Configure Offerings
« Manage Implementation Projects View » Format v {i[] Freeze ;ﬂ" Detach <l Wrap Download Domain Connections »
Setup Data Export and Import External oy
« Manage Configuration Packages Mame External Server Host Server Erire “ontext Root
« Manage Export and Import Processes EoeE
. ) > Image Process Management 443 or I
Iniplenseqtation ihjecrs  Inbound Refinery 443 or
» Manage Offerings and Functional Areas > Zms Stock Quote G
= Manage Features
= Manage Business Processes fr 200 Bans et L)
» Manage Task Lists and Tasks > WLM
= Manage Business Objects > TopologyManagerService 443 or...
Topology Objects & Setup Web Services Policy Ma 443 or...
+ Manage Domains [ Setup S0 ] Bl
+ Manage Enterprise Applications > SetupESS 3 or
» Manage Third Party Applications  Setup Diagnostic Dashboard 443 or
+ Manage Modules & Setup 443 ar
# At Compieties & Security Token Service
Topology Registration » Search ESS 43 or...
» Review Topology 4 & 5T Conference or...
& PJEPG Primavera Application 75+ 8030 or..
& Oracle University or.
 Orade Portal Home or
> Oracle Fusion Applications Tec
| Applications Core Setup fs-vour<loud-hostname 443 ar
fndwebServices L@ frdwwebServices
fndsetup fndSetup
fndAppCareServices fndAppCareServices
| Search: Tasks & Oracle Fusion Applications For or...
. ©» Oracle Documentation Portal or...
Semeh . > My Orade Support Communitie or -
3]
Advanced

7. Replace the domainName server:PortNumber with the external virtual host and port
identified in the previous step. For example:

https://fs-your-cloud-hostname:port/fndAppCoreServices/
ServiceCatalogService?wsdl

Obtaining the Event Catalog URL

You must know the CRM URL format to access the CRM application user interface. Follow
the URL format to determine the event catalog URL. For example, if the CRM URL format is:

https://fusxxxx-crm-ext.us.oracle.com/customer/faces/CrmFusionHome

Then the event catalog URL is:

https://fusxxxx-crm-ext.us.oracle.com/soa-infra

Obtaining the Authentication Credentials

Obtain the user name and password that are required for creating the Credential Store
Framework (CSF) authentication key in Oracle JDeveloper from your SOA domain
administrator. These credentials are required for most cloud adapters.

Unsupported Features

The adapter does not support the following features:

*  Adapter runtime retry configuration properties such as jca.retry.count,
jca.retry.backoff, jca.retry.interval, and jca.retry.maxInterval.

ORACLE 1.5



Chapter 1
Restrictions

* Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion

Middleware Control.

* The display of properties in the Properties tab for a reference (outbound) adapter

in Oracle Enterprise Manager Fusion Middleware Control (for example, service
WSDL URL, CSF key used, and others). These are the reference adapters that
you select on the Services and References page.

* Rejected message handling

*  Metrics such as the number of invocations.

»  The following message encryption and decryption features available when you
right-click a cloud adapter in the Exposed Service swimlane or External
References swimlane in Oracle JDeveloper:

— Protect Sensitive Data > Encrypt Request Data for cloud adapters in the
Exposed Service swimlane.

— Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the
External References swimlane.

* The policy attachments feature available when you right-click a cloud adapter in
the Exposed Service swimlane or External References swimlane in Oracle
JDeveloper.

Restrictions

ORACLE

Note the following restrictions:

Not all Oracle Fusion Application services are available in SaaS mode because the
Oracle Fusion Application topology splits visibility to web and service resources into
two categories: internal and external. Therefore, some services are internal and
cannot be used by the adapter for integration. Only external services are available for
public consumption.

The adapter cannot be used for integrating the interfamily modules, because services
defined on them are not external services.
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Understanding Oracle ERP Cloud Adapter
Features

The Oracle ERP Cloud adapter provides the following features.

Topics

» Designing an Integration with the Adapter Configuration Wizard

*  Monitoring Your Application During Runtime

Designing an Integration with the Adapter Configuration Wizard

You use the Adapter Configuration Wizard to include the Oracle ERP Cloud adapter in a SOA
composite application or an Oracle Service Bus business service.

ORACLE

The Adapter Configuration Wizard consists of configuration pages that enable you to select
the artifacts required to communicate with the Oracle ERP Cloud application. You can
configure the adapter in the inbound (source) direction or the outbound (target) direction.

# Note:

If the Localize Files dialog is displayed during adapter configuration, click Cancel.
You cannot localize the WSDL file.

* Inbound (source) direction:

The Basic Info page prompts you to enter a meaningful name and optional
description.

The Connection page prompts you to specify the WSDL, security policy, and CSF
authentication key to use. The authentication key is created by clicking the Add icon
to specify the key name, user name, and password.

You can also test the connection to the Oracle ERP Cloud application on the
Connection page. This enables you to confirm that the URL to the service catalog
service and credentials are correct. Status is displayed that indicates whether the
connection is successful and whether the credentials are authenticated by the Oracle
ERP Cloud application. Any errors that occurred during the attempt to connect are
also displayed.

The Request page prompts you to select the business object to receive as a request
from the Oracle ERP Cloud Application.

To get all available data objects in the Oracle ERP Cloud instance, the adapter first
reads the schema document (.XSD) that is referenced in the service’s WSDL. The
adapter then parses this XSD to obtain the list of all schema imports and shows them
as data objects.
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Designing an Integration with the Adapter Configuration Wizard

For example, the adapter displays the opportunity business object and its
useful metadata first by reading the opportunity service’s WSDL and the
referenced schema OpportunityService.xsd file. The XSD in turns imports
another schema Opportunity.xsd in which the opportunity business object is
defined. The metadata for the opportunity business object is defined in this
schema.

A search facility is provided that enables you to filter the display of business
objects for quick selection. When you enter a search string, the list renders

only the matching business objects in the list browser instead of showing all
objects.

— The Response page prompts you to select the business object for the
integration to send as a response document to the Oracle ERP Cloud
application. To send no response, select None. You can also optionally select
to send an immediate response back to the Oracle Sales ERP application. An
immediate response indicates a conversational response. For an immediate
response, you can select any of the data objects as a response document.

— The Summary page displays your selections.
*  Outbound (source) direction:

— The Basic Info page prompts you to enter a meaningful name and optional
description. This is the same page as is displayed for the inbound direction.

— The Connection page prompts you to specify the WSDL, security policy, and
CSF authentication key to use. The authentication key is created by clicking
the Add icon to specify the key name, user name, and password. You can
also test the connection to the Oracle ERP Cloud application on the
Connection page. This enables you to confirm that the URL to the service
catalog service and credentials are correct. Status is displayed that indicates
whether the connection is successful and whether the credentials are
authenticated by the Oracle ERP Cloud application. Any errors that occurred
during the attempt to connect are also displayed.

— The Operations page prompts you to select a business object or service and
the operation to perform on your selection.

A search facility based on service names is also provided. To quickly select a
business service, you type a search string. The list renders only matching
business services in the list browser instead of showing all services.

— The Summary page displays your selections for the outbound direction.

The following artifacts are created for each adapter instance in the Applications
window in Oracle JDeveloper:

WSDL file: Only the standard WSDL file type is supported.

* JCAfile: Contains the internal implementation details used by the adapter during
runtime. It contains the different interaction and connection properties used by the
adapter.

When application configuration is complete, you can deploy the application from
Oracle JDeveloper to the runtime environment.
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Monitoring Your Application During Runtime

< Note:

The wizard does not support the creation of response message callbacks. As an
alternative, you can design your BPEL process to include activities that support
callbacks.

# Note:

If you re-edit an already configured Oracle ERP Cloud adapter service or reference,
the service catalog WSDL is replaced with the service URL. You must re-enter the
service catalog WSDL for the adapter to work correctly.

For information about the details to specify in the fields of the wizard pages, see Configuring
Oracle ERP Cloud Properties.

Monitoring Your Application During Runtime

You can monitor your application from the runtime environment.

You use the runtime part of the adapter for delivering the information generated during design
time to the service endpoint. You can monitor your SOA composite application or Oracle
Service Bus business service from Oracle Enterprise Manager Fusion Middleware Control.
You can also test and monitor your Oracle Service Bus business service from Oracle Service
Bus Console. However, you cannot monitor the service and reference metrics for the
adapters in Oracle Enterprise Manager Fusion Middleware Control.
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Designing SOA Composite Applications

This section describes how to design a SOA composite application with the Oracle ERP
Cloud adapter.

Topics

Creating a SOA Composite Application
Adding an Adapter to a SOA Composite Application as a Service or Reference

Completing Design of a SOA Composite Application

Creating a SOA Composite Application

This section provides an overview of how to create a SOA composite application in which to
include the adapter as an exposed service or external reference.

1.
2.
3.

Start Oracle JDeveloper.
From the File menu, select New > Application.

In the New Gallery dialog, select SOA Application from the Items list, then click OK.
The SOA Create SOA Application wizard is displayed.

Specify an application name, and click Next.
Specify a project name, and click Next.
Select Composite with BPEL Process, and click Finish.

The SOA composite application is displayed for designing in the SOA Composite Editor.

Adding an Adapter to a SOA Composite Application as a
Service or Reference

You can add an Oracle ERP Cloud adapter to a SOA composite application as an inbound
(source) service to the Exposed Services swimlane or as an outbound (target) reference to
the External References swimlane in Oracle JDeveloper.

ORACLE

1.
2.

Go to the Component Palette in your SOA composite application.
Go to the Cloud section under Custom/Third Party.

The adapters are displayed.

Drag the adapter to the appropriate swimlane:

a. To create an inbound (source) service, drag the adapter to the Exposed Services
swimlane, and see the following sections that describe the wizard pages for
configuring the adapter:

»  Configuring Basic Information Properties

*  Configuring Oracle Cloud Adapter Connection and CSF Key Properties
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Completing Design of a SOA Composite Application

»  Configuring Oracle ERP Cloud Source Request Properties
»  Configuring Oracle ERP Cloud Source Response Properties
* Reviewing Configuration Values on the Summary Page

b. To create an outbound (target) reference, drag the adapter to the External
References swimlane, and see the following sections that describe the wizard
pages for configuring the adapter.

»  Configuring Basic Information Properties
»  Configuring Oracle Cloud Adapter Connection and CSF Key Properties
»  Configuring Oracle ERP Cloud Target Operation Properties

* Reviewing Configuration Values on the Summary Page

Completing Design of a SOA Composite Application

ORACLE

This section provides an overview of how to complete design of your SOA composite
application and deploy the application.

1. Design the remaining contents of your SOA composite application. For example:

a. Connect the BPEL process to the adapter. For this example, the BPEL
process is connected to the adapter as an external reference.

b. Design the contents of the BPEL process. For example:
i. Double-click the BPEL process.

ii. Add and configure an invoke activity to invoke the adapter.
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Completing Design of a SOA Composite Application
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Add and configure assign activities to copy the contents of one variable to
another when sending and receiving messages to and from the adapter.
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Add and configure other activities, as appropriate.
When complete, view the SOA composite application in the SOA
Composite Editor.
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For specific information about creating and designing SOA composite applications,
see Developing SOA Applications with Oracle SOA Suite.

2. Deploy the SOA composite application:

ORACLE"
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Completing Design of a SOA Composite Application

¢ Note:

You cannot use Oracle JDeveloper to deploy a SOA composite application to
Oracle SOA Cloud Service.

a. In the navigator, right-click the project and select Deploy > project_name.

b. Follow the steps in the deployment wizard to deploy the SOA composite application
to the application server.
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Designing Oracle Service Bus Business
Services

This section describes how to design an Oracle Service Bus business service with the
adapter in Oracle JDeveloper.

Topics
e Creating an Oracle Service Bus Business Service
* Adding an Adapter to a Business Service as a Service or Reference

e Completing Design of an Oracle Service Bus Business Service

Creating an Oracle Service Bus Business Service

This section provides an overview of how to create an Oracle Service Bus business service in
which to include the adapter in Oracle JDeveloper.

1. Start Oracle JDeveloper.
2. From the File menu, select New > Application.

3. Inthe New Gallery dialog, select Service Bus Application from the Items list, then click
OK.

4. Specify an application name, and click Next.
5. Specify a project name.
6. Select Service Bus, and click Finish.

The Oracle Service Bus business service is displayed for designing in the Oracle Service
Bus Overview Editor.

Adding an Adapter to a Business Service as a Service or
Reference

ORACLE

You can add the adapter to an Oracle Service Bus business service as an inbound (source)
proxy service to the Proxy Services swimlane or as an outbound (target) external service to
the External Services swimlane in Oracle JDeveloper.

¢ Note:
If the Import OSB Resource dialog is displayed during adapter configuration, click

Cancel. You cannot localize the WSDL file.

1. Go to the Component Palette in your Oracle Service Bus business service.
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Completing Design of an Oracle Service Bus Business Service

Go to the Cloud section under Service Bus.

The adapters are displayed.

Drag the adapter to the appropriate swimlane:

a.

To create an inbound (source) proxy service, drag the adapter to the Proxy
Services swimlane, and see the following sections that describe the wizard
pages for configuring the adapter:

»  Configuring Basic Information Properties

»  Configuring Oracle Cloud Adapter Connection and CSF Key Properties
*  Configuring Oracle ERP Cloud Source Request Properties

*  Configuring Oracle ERP Cloud Source Response Properties

* Reviewing Configuration Values on the Summary Page

To create an outbound (target) external service, drag the adapter to the
External Services swimlane, and see the following sections that describe the
wizard pages for configuring the adapter:

»  Configuring Basic Information Properties
»  Configuring Oracle Cloud Adapter Connection and CSF Key Properties
»  Configuring Oracle ERP Cloud Target Operation Properties

* Reviewing Configuration Values on the Summary Page

Completing Design of an Oracle Service Bus Business

Service

ORACLE

This section provides an overview of how to complete design of your Oracle Service
Bus business service and deploy the application.

1.

Design the contents of your Oracle Service Bus business service. For example, to
configure an Oracle Service Bus proxy service in your business service:

a.

c

2 o

In the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins
lane and select Insert > Pipeline.

The Create Pipeline Service dialog is displayed.

Enter a name for the pipeline and select the project location, then click Next
Select WSDL as the Service Type.

To the right of the WSDL selection, click the Browse icon to select the WSDL.
Select Application.

Expand Resource Chooser and select the WSDL file, then click OK.

Ensure that Expose as a Proxy Service is selected.

From the Proxy Transport list, select http, then click Finish.

The Pipeline component is displayed in the Oracle Service Bus Overview
Editor.

Connect the external service to the Pipeline component.
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For more information about creating and designing an Oracle Service Bus business
service, see Developing Services with Oracle Service Bus.

Open the pipeline that shows the default routing.

Verify the service and corresponding operation are displayed in the Routing Properties
tab at the bottom of the dialog.

The outbound project is ready for deployment.

Deploy the business service.

" Note:

You cannot use Oracle JDeveloper to deploy a business service to Oracle SOA
Cloud Service.

a. Select the project, then select Deploy to Service Bus Server.

b. Follow the steps in the deployment wizard.
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Configuring Oracle ERP Cloud Properties

The Oracle ERP Cloud adapter enables you to create integrations with an Oracle ERP Cloud
application.

The following sections describe the wizard pages that guide you through configuration of the
Oracle ERP Cloud adapter as a source and target in an integration.

Topics

e Configuring Basic Information Properties

e Configuring Oracle Cloud Adapter Connection and CSF Key Properties

e Configuring Oracle ERP Cloud Source Request Properties

e Configuring Oracle ERP Cloud Source Response Properties

e Configuring Oracle ERP Cloud Target Operation Properties

* Reviewing Configuration Values on the Summary Page

For more information about Oracle ERP Cloud, see Configuring Oracle ERP Cloud
Properties.

Configuring Basic Information Properties

You can enter a name and description on the Basic Info page of each source and target
adapter in your integration.

Topics

e What You Can Do from the Basic Info Page

e What You See on the Basic Info Page

What You Can Do from the Basic Info Page

ORACLE

You can specify the following values on the Basic Info page. The Basic Info page is the initial
wizard page that is displayed whenever you drag an adapter to the trigger (source) or invoke
(target) area supported by your adapter.

*  Specify a meaningful name.

»  Specify a description of the responsibilities.
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What You See on the Basic Info Page

The following table describes the key information on the Basic Info page.

Element

Description

What do you want to call your endpoint?

Provide a meaningful name so that others can
understand the responsibilities of this
connection. You can include English alphabetic
characters, numbers, underscores, and
dashes in the name. You cannot include the

following:
e Blank spaces (for example, My Inbound
Connection)

e Special characters (for example, #;83&
or righ (t)nowd)
e Multibyte characters

What does this endpoint do?

Enter an optional description of the
connection’s responsibilities. For example:
This connection receives an inbound
request to synchronize account
information with the cloud
application.

Configuring Oracle Cloud Adapter Connection and CSF Key

Properties

Enter the Oracle Cloud adapter configuration connectivity and Credential Store
Framework (CSF) key values for your integration.

Topics

*  What You Can Do from the Oracle Cloud Adapter Connection Page

* What You See on the Oracle Cloud Adapter Connection Page

*  What You Can Do from the Oracle Cloud Adapter CSF Key Page

*  What You See on the Oracle Cloud Adapter CSF Key Page

What You Can Do from the Oracle Cloud Adapter Connection Page

You can specify the following connection values for the Oracle Cloud adapter.

*  Specify the WSDL URL for some adapters. If you are configuring the Oracle
Eloqua Cloud adapter, no WSDL is required.

*  Specify the security policy.

* Create the authentication key. A key created for one direction (for example,
outbound) is also available for selection in the other direction (for example,

inbound).

ORACLE
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What You See on the Oracle Cloud Adapter Connection Page

The following table describes the key information on the Oracle Cloud adapter Connection

page.
Element Description
WSDL URL Note: This field is not displayed for the Oracle

Eloqua Cloud adapter.

Specify the WSDL. The WSDL is used to build
integrations specific to your instance. You can also
select the WSDL from a file system or another
source by choosing the browser icon next to the
WSDL URL field. Click File System at the top of
the dialog, then browse for the WSDL.

Security Policy

Select the security policy appropriate to your
environment (for example,
USERNAME_PASSWORD_TOKEN).

*  The wizard shows all policies, including those
that may not be applicable. To make a correct
selection, you must have a knowledge of
policies. For example, you cannot select a
SAML-based policy because the identity is
not propagated.

e The policies you apply to the cloud adapter
are unique to the cloud adapter and do not
impact other endpoints in the composite.

Authentication Key

Select the CSF authentication key.

* Add: Click to create a new authentication key.
You must specify the key name, user name,
and password.

»  Edit: Click to edit an authentication key.
* Delete: Click to delete an authentication key.

Test

Click to validate the authentication key.

What You Can Do from the Oracle Cloud Adapter CSF Key Page

You can specify the following CSF key values for the Oracle Cloud adapter.

e CSF key name

e User name and password

» If you are configuring the Oracle Eloqua Cloud adapter only, you must specify a company

name.

ORACLE
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What You See on the Oracle Cloud Adapter CSF Key Page

The following table describes the key information on the Oracle Cloud adapter CSF

Key page.

Element

Description

CSF Key Name

Specify the CSF key to enable runtime
injection of credentials. The adapter uses the
CSF to retrieve the username and password
required for authentication with the application
(for example, the Oracle Sales Cloud or Oracle
ERP application). This key identifies your login
credentials during design-time.

Company Name (Oracle Elogua Cloud
adapter only)

Note: This field is only displayed for the Oracle
Eloqua Cloud adapter.

Specify the Oracle Eloqua company name.

Email Account and Role

Note: This field is only displayed for the Oracle
NetSuite Cloud adapter.

Specify the email account and role.

User Name

Enter the user name for connecting to your
application (for example, the Oracle Sales
Cloud or Oracle ERP application). Your
administrator provides you with user
credentials.

Password

Enter the password for connecting to your
application.

Re-enter Password

Re-enter the same password a second time.

Application ID (NetSuite Adapter only)

Enter the application ID. When creating a SOA
composite application, this field is optional if
you are using a NetSuite 2015 WSDL and
mandatory if using a NetSuite 2016 WSDL.

Configuring Oracle ERP Cloud Source Request Properties

Enter the Oracle ERP Cloud connection source request values for your integration.

The values you specify start the integration.

Topics

e What You Can Do from the Oracle ERP Cloud Trigger Request Page

* What You See on the Oracle ERP Cloud Source Request Page

What You Can Do from the Oracle ERP Cloud Trigger Request Page

You can select the following trigger request values for the Oracle ERP Cloud

ORACLE

application.

Select the specific type to receive as a request from Oracle ERP Cloud. Your ability to
select either a business object or event subscription is based on the content of the
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WSDL file (for business objects) or event catalog URL (for event subscriptions) you specified
during Oracle ERP Cloud Adapter configuration.

» Select to receive a business object as a request from the Oracle ERP Cloud application.
This selection invokes the integration.

» Select to receive an event subscription raised by the Oracle ERP Cloud application as a
request from Oracle ERP Cloud. This selection invokes the integration.

# Note:

If the options for selecting business objects and events are missing, that indicates
that the event catalog URL was not supplied on the Connection page.

What You See on the Oracle ERP Cloud Source Request Page

The following table describes the key information on the Oracle ERP Cloud source Request

page.
Element Description
Configure a Request Select the request type appropriate to your
integration. The fields that are displayed below are
based on the request type that you select.
*  With Business Objects: Select to display a
list of business objects.
*  With Business Events: Select to display a
list of business events.
Select a Business Object Select the business object from the Oracle ERP
(is displayed if With Business Objects is Cloud application to receive as a request that
selected) starts the integration.
Business Event For Subscription Select the event subscription from the Oracle ERP

(is displayed if With Business Events is selected) Cloud application. This event is received as a
request that starts the integration.

Filter Expr for Business_Event_Name Enter an event condition filter expression. A filter

(is displayed if With Business Events is selected) €xpression specifies that the contents (payload or
headers) of a message be analyzed before any
event is sent. For example, you can apply a filter
expression that specifies that an event be sent
only if the message includes a customer ID. When
the expression logic is satisfied, the event is
accepted for delivery to the integration.

Filter by object name or Filter By Event Name  Type the initial letters of the name to filter the
display of business objects or event subscriptions.

Configuring Oracle ERP Cloud Source Response Properties

Enter the Oracle ERP Cloud source response values for your integration.

Topics

*  What You Can Do from the Oracle ERP Cloud Trigger Response Page
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* What You See on the Oracle ERP Cloud Trigger Response Page

What You Can Do from the Oracle ERP Cloud Trigger Response Page

You can configure the operation and business object that comprise the response type
for the Oracle ERP Cloud application.

* Immediate (synchronous) response: A response business object is immediately
returned as output. You select Immediate as the response type on the Response
page and select the business object as part of the response to the client.

* No response is required: You select None on the Response page because a
response is not required.

What You See on the Oracle ERP Cloud Trigger Response Page

Select the business object for the integration to send as a response document to the
Oracle ERP Cloud application. The following types of responses are available.

Select the type of response appropriate to your business requirements:

* Immediate: A synchronous response is required (See Table 5-1 for instructions)
* None: No response is required (See Table 5-2 for instructions)

The following table describes the fields available if an immediate (synchronous)
response is required.

Table 5-1 Response Type — Immediate (Synchronous) Response is Required

_______________________________________________________________________|
Element Description

Response Type Select Immediate for the Oracle ERP Cloud
application to wait until a response is received
from the integration. This is also known as the
request and response message exchange
pattern. This is the default selection.

Filter by object name Enter the initial letters to filter the display of
business objects.

Select a Business Object Select the business object to receive from the
Oracle ERP Cloud application as a response.
A description of the selected business object is
displayed below this list.

Name Displays the name of the selected business
object.
Description Displays the description of the selected

business object.

The following table describes the fields available if no response is required.

Table 5-2 Response Type — None

|
Element Description

Response Type Select None.
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Configuring Oracle ERP Cloud Target Operation Properties

Element

Description

Select a Business Object

If you select None, this section is hidden.

Configuring Oracle ERP Cloud Target Operation Properties

Enter the Oracle ERP Cloud target operation values for your integration.

Topics

e What You Can Do from the Oracle ERP Cloud Target Operations Page

e What You See on the Oracle ERP Cloud Target Operations Page

What You Can Do from the Oracle ERP Cloud Target Operations Page

You can configure the following target operation values for the Oracle ERP Cloud.

» Select the business object or service.

* Select the operation to perform on the selected business object or service.

What You See on the Oracle ERP Cloud Target Operations Page

The following table describes the key information on the Oracle ERP Cloud target Operations

ORACLE

page.
Element Description
Browse by Select to browse by business object or service.

There is a one-to-one correspondence between
the business object and service. The service acts
on the business document.

* Business Objects: Select to browse a list of
available business objects.

e Services: Select to browse a list of available
services.

Filter by object name
(displayed if Business Objects is selected)

Type the initial letters to filter the display of
business objects.

Select a Business Object
(displayed if Business Objects is selected)

Select the business object to use.

Filter by service
(displayed if Services is selected)

Type the initial letters to filter the display of
services.

Select a Service
(displayed if Services is selected)

Select the service to use.

Select the operation to perform on the
business object or service

Select the operation to perform on the selected
business object or service.
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Element Description

Life Cycle Displays the state of the selected business object
or service. Deprecated indicates the business
document is nearing the end of use and must be
used with caution.

Name Displays the name of the selected business object
or service.
Description Displays the description of the selected business

object or service.

Reviewing Configuration Values on the Summary Page

You can review the specified adapter configuration values on the Summary page.

Topics
*  What You Can Do from the Summary Page

*  What You See on the Summary Page

What You Can Do from the Summary Page

You can review source or target configuration details from the Summary page. The
Summary page is the final wizard page for each adapter after you have completed
your configuration.

*  View the configuration details you defined for the source or target adapter. For
example, if you have defined an inbound source adapter with a request business
object and immediate response business object, specific details about this
configuration are displayed on the Summary page.

» Click Done if you want to save your configuration details.

» Click a specific tab in the left panel or click Back to access a specific page to
update your configuration definitions.

* Click Cancel to cancel your configuration details.

What You See on the Summary Page

The following table describes the key information on the Summary page.

Element Description

Summary Displays a summary of the source or target
configuration values you defined on previous
pages of the wizard.

For adapters for which a generated XSD file is
provided, click the XSD link to view a read-only
version of the file.

To return to a previous page to update any
values, click the appropriate tab in the left
panel or click Back.
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Managing Applications

This section describes how to manage and monitor an Oracle SOA Suite or Oracle Service
Bus application that uses the adapter from Oracle Enterprise Manager Fusion Middleware
Control or Oracle Service Bus Console.

Topics

Managing the Application in Oracle Enterprise Manager Fusion Middleware Control

Testing Oracle Service Bus Projects from Oracle Service Bus Console

Managing the Application in Oracle Enterprise Manager Fusion
Middleware Control

You manage the SOA composite application or Oracle Service Bus business service that
includes your adapter in Oracle Enterprise Manager Fusion Middleware Control.

1.
2.

Log in to Oracle Enterprise Manager Fusion Middleware Control.

In the navigator, expand the tree to display your SOA composite application or Oracle
Service Bus business service project (for this example, a SOA composite application is
selected).

Select the SOA composite application.

Click Test.

The Test Web Service page is displayed.

Complete the fields on the page to initiate a test of your composite.
Click Test Web Service.

Invocation results are displayed.

Click Launch Flow Trace to view the flow trace of the SOA composite application,
including flow details about the adapter.

For more information about monitoring applications from Oracle Enterprise Manager
Fusion Middleware Control, see Administering Oracle SOA Suite and Oracle Business
Process Management Suite and Administering Oracle Service Bus.

Testing Oracle Service Bus Business Services from Oracle
Service Bus Console

You can test Oracle Service Bus business service projects from Oracle Service Bus Console.

1.
2.
3.

ORACLE

Log in to Oracle Service Bus Console.
In the navigator under All Projects, open the project to test.

In the navigator, click the business service for that project.
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Click the Launch Test Console (green arrow button) to test the outbound
endpoint.

This opens a window that displays the proxy service and the operation to test.
Provide the input and click Execute.

This sends the payload to the Oracle Cloud application. The response is displayed
under the Response Document section.

For more information about testing Oracle Service Bus business service projects,
see Administering Oracle Service Bus.

6-2



	Contents
	Preface
	Audience
	Related Resources
	Conventions

	1 Introduction to Oracle ERP Cloud Adapter
	Oracle ERP Cloud
	Installing the Cloud Adapters
	Performing Postinstallation Configuration Tasks
	Specifying the Oracle ERP Cloud Service Catalog Service WSDL or Event Catalog URL
	Obtaining the Authentication Credentials
	Unsupported Features
	Restrictions

	2 Understanding Oracle ERP Cloud Adapter Features
	Designing an Integration with the Adapter Configuration Wizard
	Monitoring Your Application During Runtime

	3 Designing SOA Composite Applications
	Creating a SOA Composite Application
	Adding an Adapter to a SOA Composite Application as a Service or Reference
	Completing Design of a SOA Composite Application

	4 Designing Oracle Service Bus Business Services
	Creating an Oracle Service Bus Business Service
	Adding an Adapter to a Business Service as a Service or Reference
	Completing Design of an Oracle Service Bus Business Service

	5 Configuring Oracle ERP Cloud Properties
	Configuring Basic Information Properties
	What You Can Do from the Basic Info Page
	What You See on the Basic Info Page

	Configuring Oracle Cloud Adapter Connection and CSF Key Properties
	What You Can Do from the Oracle Cloud Adapter Connection Page
	What You See on the Oracle Cloud Adapter Connection Page
	What You Can Do from the Oracle Cloud Adapter CSF Key Page
	What You See on the Oracle Cloud Adapter CSF Key Page

	Configuring Oracle ERP Cloud Source Request Properties
	What You Can Do from the Oracle ERP Cloud Trigger Request Page
	What You See on the Oracle ERP Cloud Source Request Page

	Configuring Oracle ERP Cloud Source Response Properties
	What You Can Do from the Oracle ERP Cloud Trigger Response Page
	What You See on the Oracle ERP Cloud Trigger Response Page

	Configuring Oracle ERP Cloud Target Operation Properties
	What You Can Do from the Oracle ERP Cloud Target Operations Page
	What You See on the Oracle ERP Cloud Target Operations Page

	Reviewing Configuration Values on the Summary Page
	What You Can Do from the Summary Page
	What You See on the Summary Page


	6 Managing Applications
	Managing the Application in Oracle Enterprise Manager Fusion Middleware Control
	Testing Oracle Service Bus Business Services from Oracle Service Bus Console


